Contents

Audio interface and control surface ............................................. 2
R24 Audio Interface system requirements ....................................... 4
  Cubase LE Startup Guide ...................................................... 4
Connecting and disconnecting in audio interface mode ......................... 5
  Connecting the R24 to a computer for the first time ..................... 5
  R24 setup and connection ..................................................... 5
  Disconnecting ................................................................. 6
Using control surface functions .................................................. 7
  About the control surface ..................................................... 7
  Control surface setup .......................................................... 7
  Transport section ............................................................... 8
Fader section operation ............................................................ 9
  About banks ........................................................................ 9
  Operating the fader section ..................................................... 9
  R24 level meters (Audio interface use) .................................... 10
Setting the function keys ................................................................ 11
  Function key setup ............................................................... 11
Control surface functions quick reference guide ................................. 12
Using Cubase LE template files .................................................... 13
  Create a new project ............................................................. 13
The mixer in audio interface mode ................................................ 14
  Volume, reverb send, pan ......................................................... 14
  Stereo link ........................................................................... 14
  Balance .................................................................................. 14
Tuner ......................................................................................... 15
  Chromatic tuner ................................................................. 15
Effects in audio interface mode ....................................................... 16
  INSERT effect ..................................................................... 16
  SEND return effect .............................................................. 16
Working with patches .................................................................. 17
  Patch operations ............................................................... 17
  Patch initialization (factory reset) ........................................... 17
Audio interface and control surface

This section explains how to connect the unit with a computer and how to set up and use the audio interface and control surface functions of the R24 with a DAW and other software.

Functions of the audio interface and control surface

Audio interface

The R24 has numerous inputs and outputs and it can be used as a Hi-Speed USB (USB 2.0) audio interface with 8 inputs and 2 outputs at quality up to 24-bit/96 kHz. Effects can be used when the sampling rate is 44.1 kHz, and the unit can be powered by a computer’s USB bus.

Control surface functions

On-board control surface functions can be used to control DAW software on a computer via USB. Transport operations, including playback, recording and stopping, and physical control of the DAW faders are possible. Furthermore, various other DAW software functions can be mapped to the F1~F5 keys (assignable functions depend on the DAW used).
■ Multifunction tuner

In addition to standard chromatic tuning, the on-board multifunction tuner also supports 7-string guitar, 5-string bass and various drop tunings.

■ Comprehensive built-in mixer

Using the R24’s mixer, you can make a mix for monitoring. When simultaneously recording guitar and vocals, for example, you can adjust volume balance, panning and reverb levels. Moreover, you can also adjust the balance between the built-in mixer and the sound sent from a computer.

■ Versatile effect functions

Built-in insert effects can be applied to specific channel paths, and two-types of send/return effects work via the mixer send/return. These effects can be applied when recording, of course, but they can also be applied to only the monitor output. For example, when recording vocals, you can apply reverb only to the monitor signal to make singing easier.

■ Supports input from a variety of sources, including guitars, mics and line level instruments

The 8 onboard jacks accept XLR and standard phone plugs and include one high-impedance input and two inputs with phantom power (24V or 48V). Many sources are supported from high-impedance guitars and basses to dynamic and condenser microphones and line-level devices like synthesizers. In addition, built-in high-performance condenser microphones are convenient for recording acoustic guitars and vocals.
R24 Audio Interface system requirements

Cubase LE installation guide

Please refer to the Cubase LE Startup Guide for detailed instructions for installing the R16/R24 audio driver and Cubase LE.

R24 Audio Interface system requirements

Windows
Windows® 7 (32-bit, 64-bit) or later
32-bit: Intel® Pentium® 4 1.8 GHz or faster
64-bit: Intel® Pentium® Dual Core 2.7 GHz or faster
32-bit: RAM 1 GB or faster
64-bit: RAM 2 GB or faster

Intel Mac
OS X 10.9 or later
Intel® Core Duo 1.83 GHz or faster
RAM 1 GB or faster

Both
USB 2.0 compatible port

• USB hubs are not supported.
• Intel® chipsets recommended.

Note about descriptions and images
This manual was prepared based on use with Windows systems. Special functions related to Mac OS X are indicated separately.

The screen images are of the Windows version.

About trademarks
• The SD symbol and SDHC symbol are trademarks.
• Windows®, and Windows 7® are registered trademarks of Microsoft® in the USA.
• Macintosh® and Mac OS® are trademarks of Apple Inc.
• Steinberg and Cubase are registered trademarks of Steinberg Media Technologies GmbH Inc.
• Intel® and Pentium® are trademarks of Intel Corporation.
• MACKIE Control is a registered trademark of LOUD Technologies.
• All other product names, registered trademarks, and company names mentioned in this documentation are the property of their respective owners.

In order to improve the product, specifications might be changed without advance notice.
Connecting and disconnecting in audio interface mode

This is an overview of connecting and disconnecting the R24 to a computer with a USB cable. For details, see the included “Cubase LE Startup Guide”.

### Connecting the R24 to a computer for the first time

1. Install the Cubase LE DAW software on the computer.
2. Install the audio driver on the computer from the included CD-ROM.
3. Connect the R24 to a computer.
4. Setup the DAW software.

#### R24 setup and connection

Follow these procedures when connecting again.

1. Press USB.
2. Select AUDIO I/F.
3. Select EXECUTE.

#### Installation and setup details

- **NOTE**
  - The ZOOM R16/R24 audio driver is essential for using the R24 as an audio interface with DAW software such as Cubase LE. When downloading it, follow the included installation guide to install it correctly.
  - Download the latest R24 audio driver from the Zoom Corporation website.
    
http://www.zoom.co.jp/
Connect the USB cable to the R24.

Connect the USB cable to the computer.

NOTE

Select CONTINUE to use the same settings as last time.
- INSERT EFFECT settings
- SEND RETURN EFFECT settings
- Mixer settings
- TUNER settings

Select RESET to restore default settings for each item.

- The audio interface and control surface functions of the R24 can be used by drawing power through a USB cable from the USB bus.
- We recommend always using the latest R24 system software.
- When using phantom power, we recommend using batteries or an AC adapter even when the unit is used as an audio interface.
Using control surface functions

When using the R24 connected by USB as an audio interface, the R24 keys and faders can be used to control Cubase LE’s transport and mixer.

About the control surface

In control surface mode the keys and knobs on the R24 can be assigned to particular Cubase LE functions.

Control surface setup

See R24 setup and connection steps 1–5 on P5–6

Then, launch Cubase LE.

From the Cubase LE “Devices” menu, select “Device setup…”

At the top left of the Device setup window [+] [−] and [|<] buttons appear. Click the [+] and select “Mackie Control”

Set the MIDI input and output

MIDI input: ZOOM R16_R24
MIDI output: ZOOM R16_R24

HINT

Assigning keys

For a list of functions that can be assigned to the knobs and keys of the R24, as well as other transport/function keys that are supported by Cubase LE, please consult the “Control surface functions quick reference guide” in this manual.

HINT

The display of MENU etc. may be different depending on the version of Cubase LE. Please refer to your Cubase LE manual.
By setting up the control surface, the R24’s transport section keys can be assigned to individual functions in Cubase LE.
Fader section operation

Using the faders and status keys of the fader section, you can adjust the volume of corresponding Cubase LE tracks, mute and solo them, and arm them for recording.

About banks

After setting up control surface operation, the main parameters of Cubase LE can be operated using the R24’s fader and status keys.

A group of tracks operated by the faders and status keys is called a “bank.” With the R24, one bank of 8 adjacent tracks can be controlled.

For example, if fader 1 is assigned to Cubase LE track 1, tracks 1-8 can be controlled as shown in the following diagram.

<table>
<thead>
<tr>
<th>Control</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Tr.1</td>
<td>Tr.2</td>
<td>Tr.3</td>
<td>Tr.4</td>
<td>Tr.5</td>
<td>Tr.6</td>
<td>Tr.7</td>
<td>Tr.8</td>
</tr>
</tbody>
</table>

As the diagram shows, when tracks 1~8 are selected, pressing the [9~16tr (Bank>)] key once switches the assignments as shown below.

<table>
<thead>
<tr>
<th>Control</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Tr.9</td>
<td>Tr.10</td>
<td>Tr.11</td>
<td>Tr.12</td>
<td>Tr.13</td>
<td>Tr.14</td>
<td>Tr.15</td>
<td>Tr.16</td>
</tr>
</tbody>
</table>

1~8Tr

1~8Tr (< BANK) key
Tracks (channels) assigned to the fader section are moved backward by eight tracks.

9~16Tr

9~16Tr (BANK >) key
Tracks (channels) assigned to the fader section are moved forward by eight tracks.

Operating the fader section

1. Assign the Cubase LE tracks (channels) that you want to control to the fader section.

2. Use the faders to control the volumes of the corresponding tracks.

   The faders control the volumes of their respective tracks. Change the master volume by moving the [Master] Fader.

3. To change the function of the status keys for all the tracks, press the soft key for the desired function.
R24 level meters
(Audio interface use)

Each level meter other than the MASTER displays the signal immediately before sending it to the computer.

The master level meter displays the returning signal from the computer.

Checking DAW recording levels
Set “REC SIGNAL” (in the INSERT EFFECT menu) to “WET” (signal with effect) or “DRY” (no effect) to send signals to the computer with or without being processed by the insert effects. The recording levels of the sent signals are displayed on the level meters. The signal shown on the master level meter differs from that shown on each level meter.

Adjust the levels so that the red (0 dB) clipping indicators on the meters do not light.

Red light (clipping)
Setting the function keys

The five keys above the transport keys can be used as function keys (F1~F5) and assigned as desired.

Function key setup

1. Open the “Device setup…” dialog in Cubase LE.

2. Select “Mackie Control”.
   Commands can be assigned using the three columns displayed on the right side of the window.

3. From the “Button” column choose the function key (F1~F5) to be assigned a Cubase LE function.

4. Click on the “Category” column for that control.

5. Choose the type of Cubase LE function from the Category pop-up menu.

6. Click on the “Command” column and select the desired Cubase LE function from the pop-up menu.
   The items in this pop-up menu will differ depending on the category chosen.

7. Press the “Apply” button.

HINT
The display of MENU etc. may be different depending on the version of Cubase LE. Please refer to your Cubase LE manual.
<table>
<thead>
<tr>
<th>Control section</th>
<th>Control</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fader section</strong></td>
<td>Status keys</td>
<td>Turns mute, solo or record arming on/off for the track</td>
</tr>
<tr>
<td></td>
<td>Faders</td>
<td>Controls the volume of the corresponding tracks</td>
</tr>
<tr>
<td></td>
<td><strong>MASTER Fader</strong></td>
<td>Master volume operation</td>
</tr>
<tr>
<td><strong>Display section</strong></td>
<td>Soft keys</td>
<td>Change functions of status keys/End connection (EXIT)</td>
</tr>
<tr>
<td><strong>Transport section</strong></td>
<td>Cursor keys</td>
<td>Performs the same functions as the computer arrow keys</td>
</tr>
<tr>
<td></td>
<td>DIAL</td>
<td>Moves the project cursor position</td>
</tr>
<tr>
<td></td>
<td><strong>REW key</strong></td>
<td>Rewind</td>
</tr>
<tr>
<td></td>
<td><strong>FF key</strong></td>
<td>Fast forward</td>
</tr>
<tr>
<td></td>
<td><strong>STOP key</strong></td>
<td>Stop</td>
</tr>
<tr>
<td></td>
<td><strong>PLAY key</strong></td>
<td>Play</td>
</tr>
<tr>
<td></td>
<td><strong>REC key</strong></td>
<td>Record</td>
</tr>
<tr>
<td></td>
<td><strong>AUTO PUNCH I/O key</strong></td>
<td>Depends on the [F1] key setting</td>
</tr>
<tr>
<td></td>
<td><strong>A-B REPEAT key</strong></td>
<td>Depends on the [F2] key setting</td>
</tr>
<tr>
<td></td>
<td>[leton] (marker) key</td>
<td>Depends on the [F3] key setting</td>
</tr>
<tr>
<td></td>
<td>[leton] (marker) key</td>
<td>Depends on the [F4] key setting</td>
</tr>
<tr>
<td></td>
<td><strong>MARK/CLEAR key</strong></td>
<td>Depends on the [F5] key setting</td>
</tr>
<tr>
<td><strong>Control section</strong></td>
<td><strong>1-8Tr key</strong></td>
<td>Moves one bank forward</td>
</tr>
<tr>
<td></td>
<td><strong>9-16Tr key</strong></td>
<td>Moves one bank backward</td>
</tr>
</tbody>
</table>
Using Cubase LE template files

Create a new project

1. Copy the ZOOM R24 project templates to the computer.

   From the CubaseLE5_template folder on the CD included with R24, copy the templates to the location where Cubase LE is installed.

   **Windows**
   The folder opened by clicking Start>Steinberg Cubase LE XX>User Settings Data Folder

   **Macintosh**
   /Applications/CubaseLE XX.app/Contents/templates/

   “XX” varies depending on the version installed.

2. Launch Cubase LE and select File > New Project.
   Depending on your settings, either the Steinberg Hub or the Project Assistant dialog opens.

3. Create a new project
   After copying the R24 project templates to the designated folder, the R24 project templates will be displayed when creating a new project. By choosing these templates you will be able to easily create projects with audio track input and output settings already arranged for the R24.

**Template names and details**

- **ZOOM R16_R24 8Mono Recording**
  Project with Cubase LE mono tracks 1~8 assigned to R24 INPUTS 1~8

- **ZOOM R16_R24 4Stereo Recording**
  Project with Cubase LE stereo tracks 1~4 assigned to R24 INPUTS 1/2 ~ 7/8

- **ZOOM R16_R24 4Mono 2Stereo Recording**
  Project with Cubase LE mono tracks 1~4 assigned to R24 INPUTS 1~4 and Cubase LE stereo tracks 5~6 assigned to R24 INPUTS 5/6 and INPUTS 7/8

**Tips to improve performance**

When using Cubase LE, application performance could become extremely delayed or error messages such as “cannot synchronize with USB audio interface” might be displayed. Should such occurrences become frequent, the following measures might improve the situation.

1. **Terminate programs other than Cubase LE that are running.**
   In particular, confirm that many background applications are not running.

2. **Reduce the use of plug-ins (effects, virtual instruments)**
   If a large number of plug-ins are running, the computer processing capacity might not be able to keep up. In addition, reducing the number of simultaneous playback tracks might be effective.

3. **Use the R24 AC adapter**
   When devices draw power from the USB bus, on rare occasions computer performance can suffer. Try using the AC adapter.

   If the sound breaks up, please increase the Audio Buffer Size in the Device Setup… menu > VST Audio System window.
   Moreover, if the application performance is extremely slow and regular computer operation is affected, we recommend quitting Cubase LE and disconnecting the R24 USB port from the computer once, and then reconnecting the USB port and relaunching Cubase LE.

**Windows**

The folder opened by clicking Start>Steinberg Cubase LE XX>User Settings Data Folder

**Macintosh**

/Applications/CubaseLE XX.app/Contents/templates/
The mixer in audio interface mode

In audio interface mode you can make a mix for monitoring using the R24’s internal mixer. In addition, you can adjust the balance of the internal mixer and the sound from the computer.

**Volume, reverb send, pan**

You can be adjust the reverb send, pan, volume and stereo link settings as in recorder mode.
Operation is the same as in recorder mode.
(Reference: OPERATION MANUAL)

### PAN/EQ menu

**VOLUME**
Adjust the volumes of INPUTS 1~8.

| INPUT 1 |  |
|--------|--
| PAN    | L100  |
| REV SEND | OFF |
| VOLUME | 0 |
| ST LINK | OFF |
| ON/OFF |  |

**REV SEND**
Adjust the reverb send levels of INPUTS 1~8.

| INPUT 1 |  |
|--------|--
| PAN    | L100  |
| REV SEND | 0 |
| VOLUME | 0 |
| ST LINK | OFF |

**PAN (BALANCE)**
Adjust the pan for INPUTS 1~8.

| INPUT 1 |  |
|--------|--
| PAN    | L100  |
| REV SEND | OFF |
| VOLUME | 0 |
| ST LINK | OFF |

### Stereo link

Link even and odd numbered INPUTS to handle them as stereo pairs.

**NOTE**

The reverb send, pan, volume and stereo link settings are all saved when you terminate (EXIT) audio interface mode and can be used again the next time.
The R24 tuner can be used as when recording. For details, see the Operation Manual.

**Chromatic tuner**

TOOL > TUNER

1. Press TOOL.

2. Select TUNER.

3. Tune the instrument.

4. To change the standard pitch, press the beneath CALIB.

5. Select the standard pitch.

   **TUNER CALIBRATION**
   
<table>
<thead>
<tr>
<th>TUNER CALIBRATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>440Hz</td>
</tr>
<tr>
<td>441Hz</td>
</tr>
<tr>
<td>442Hz</td>
</tr>
<tr>
<td>443Hz</td>
</tr>
<tr>
<td>444Hz</td>
</tr>
</tbody>
</table>

   Press ENTER.

4. To change the tuner type, press the beneath TYPE.

5. Change the tuner type.

   **TUNER TYPE**
   
<table>
<thead>
<tr>
<th>TUNER TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHROMATIC</td>
</tr>
<tr>
<td>GUITAR</td>
</tr>
<tr>
<td>BASS</td>
</tr>
<tr>
<td>OPEN-A</td>
</tr>
<tr>
<td>OPEN-D</td>
</tr>
</tbody>
</table>

   Change the standard pitch
   Change the tuner type

**HINT**

- The default value of the standard pitch is 440 Hz.
- Tuners other than the chromatic tuner can also be used.
Reference: Operation Manual)

**NOTE**

Tuner settings are saved when you terminate (EXIT) audio interface mode and can be used again the next time.

Reference: Operation Manual

Tuner

Change menu

Change the standard pitch

Press ENTER.
Effects in audio interface mode

The R24’s insert and send-return effects can both be used when the sampling frequency is set to 44.1 kHz. Basic operation is the same but there are a few differences in the menus.

**Insert effect**

As in recording mode, you can select the insert location and the insert effect algorithm, as well as the effect patches to be applied to the signal being recorded.

**Send return effect**

As in recorder mode, use the **Send Reverb** menu to change the patch and use the **PAN/EQ** menu to set the **Rev Send** level that adjusts the reverb depth.

**NOTE**

- Effects can only be used when the sampling rate is 44.1 kHz. At all other times it is turned OFF.
- Insert and send return effect settings are saved when you terminate **(EXIT) audio interface mode** and can be used again the next time.
After making many changes, you can restore a patch to its pre-edited settings by initializing it. This will return it to its factory preset condition.

### Patch operations

#### For both insert and send return effects

**Selecting insert effect/reverb patches**

To use an insert effect, select an algorithm and a patch.
To use a send reverb effect, select a patch.
(Reference: Operation Manual)

**Editing patches (EDIT)**

By adjusting effect module parameters and levels, you can create the desired result. (Reference: Operation Manual)

**Importing patches (IMPORT)**

All effect algorithms (and reverb patches) or a single one can be imported from a selected project on the R24.
(Reference: Operation Manual)

In audio interface mode, one complete set of effect data is saved for the mode. There are no project-based settings.

**Saving patches (SAVE)**

Edited patches can be saved.
(Reference: Operation Manual)

**Initializing patches (INITIAL)**

Restores patches to their original factory settings (only available in audio interface mode).

**Changing patch names (RENAME)**

The name of the currently selected patch can be changed.

---

### Patch initialization (factory reset)

EFFECT > INITIAL

#### Turning effects on/off

**Insert effect**

Press the [ ] beneath INSERT.

**Send return effect**

Press the [ ] beneath REVERB.

The following example is of an insert effect.

#### Turn the effect On.

**Select INITIAL.**

**Select YES.**

Press ENTER.
Cubase LE  Startup Guide

1. Install Cubase LE referring to the bundled ‘Download access code sheet’.

2. Download the latest driver from ZOOM website (www.zoom.co.jp) and install it.

3. Connect the ZOOM unit to the computer. Please refer to Operation Manual how to connect.

4. Startup Cubase LE, select "Device Setup..." from the "Devices" menu, and click "VST audio system" in the Devices Column. Select the downloaded driver or the devices including the ZOOM model names here. e.g. H Series Multi Track is shown as following.

5. Select "VST Connections" from "Devices" menu and set the input and output device ports to the downloaded driver or the devices including the ZOOM model names. For multi-track supported models, click "Add Bus" and add the input bus. e.g. H Series Multi Track is shown as following.

6. Select "New Project" from the "File" menu. "Project Assistant" window opens in order to select a project template. Click "More", select "Empty", and then click the "Create" button to display the project window.

7. Select "Add Track"->"Audio" from "Project" menu and add new audio track.

8. Click "Record" button on the Transport panel and start recording. Recording starts. Click "Stop" button to stop recording.

9. Click "Play" button to check the recording.

This is all for the basic setting. For more information, please refer to the Documentation from "Help" in Cubase LE or visit Steinberg website (www.steinberg.net/en/home).

The Menu items are subject to change. Please refer to the Cubase LE Operation Manual in such cases.